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Conventions

PPA for DM Manual

The typographic conventions used in this manual are described below.

Convention

Bold

Menu...MenuOption

CAPS

Italics

Description

Used to denote specified elements of the user interface such as
buttons, field names, menus, and menu options.
For example, the New button.

Select the Menu from the Menu bar then select the Menu Option
from the Menu.

For example, File...Open would mean select the File Menu and
then the Open Option.

Used to denote the name of a key on the keyboard.
For example, the ENTER key.

Used to denote emphasis, captions and the result of an action in a
procedure.
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Introduction to Peak Pairs Analysis (PPA)

PPA stands for Peak Pairs Analysis, the DigitalMicrograph plug-in for High-Resolution Peak
Measurement and Strain Mapping Analysis.

All results obtained by PPA are fully compatible with the other functions present in DM. For
example, strain maps can be analyzed and/or manipulated with functions such as histograms,
statistics (mean, standard deviation, min, max etc.), or using the corresponding buttons, such
as the Profile utility.

The main reference for the algorithm is:

The Peak Pairs algorithm for strain mapping from HRTEM images

Pedro L. Galindo, Stawomir Kret, Ana M. Sanchez, Jean-Yves Laval, Andrés Yafiez,
Joaquin Pizarro, Elisa Guerrero, Teresa Ben and Sergio 1. Molina

Ultramicroscopy 107 (2007) 11861193 (doi: 10.1016/j.ultramic.2007.01.019)

The reference for the procedure of non-local noise filter is:

Evaluation of high-quality image reconstruction techniques applied to high-resolution
Z-contrast imaging

G. Barcena-Gonzalez, M.P. Guerrero-Lebrero, E. Guerrero, A. Yanez, D. Fernandez-
Reyes, D. Gonzalez, P.L. Galindo
Ultramicroscopy 182 (2017) 283-291 (doi: 10.1016/j.ultramic.2017.07.014)

This manual will help you to use of the PPA package with some worked examples. There is
also a quick reference guide at the end of this document.

Software requirements

The following is a list of the software requirements necessary to run the PPA plug-in:

- DigitalMicrograph (Gatan™ )

- USB Key Driver

-  HREM Mouse Tool Plug-in (freeware downloadable from www.hremresearch.com)
- IPU Plug-in (freeware downloadable from www.hremresearch.com)

- HREM-Filters Pro/Lite Plug-in (Lite is a freeware downloadable from
www.hremresearch.com)
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Software Installation

Installing USB Key Driver

The user key driver should be installed by following the instructions given by the key driver
installer. You can find the key driver installer at the plug-in page on HREM Research web site.

Installing DigitalMicrograph Plug-ins

The DigitalMicrograph Plug-in will be provided as Gatan compiled script file(s) (.gtk) and
dynamic link library file(s) (.dll). All these files can be installed by copy-and-paste to the folder
“Pluglns.” (The Plugins folder should exist under a normal installation of the
DigitalMicrograph).

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglns folder, the

Pluglns will appear as a new menu or an addition to the standard tools.

Installing HREM Mouse Tools

All the files relating HREM Mouse tool plug-in can be installed
by copy-and-paste to the folder “Pluglns.” The Mouse tool will

appear as an addition to the standard tools.

Installing IPU Plug-in

The PPA plug-in uses some functions based on the Inte]”’ MKL
(Math Kernel Library) provided by the IPU plug-in. All the
files relating the IPU plug-in can be installed by copy-and-paste
copy. The IPU plug-in will appear as under IPU menu. Please
consult the ReadMe file that comes with the IPU plug-in.

Installing PPA

PeakPairs.gtk and PeakPairs.dll can be installed by drag-and-
copy to the folder “Plugins” (The Pluglns folder should exist
under a normal installation of the DigitalMicrograph.)

When the DigitalMicrograph is launched after placing the plug-
ins into the Pluglns folder, PeakPairs menu commands shown
right will appear.

(] ?eakPairsii 1DPC  Help
Fourier Space Noise Filter
Real Space Noise Filter
Non-Local Noise Filter

Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference

Strain Map...

Correct Scan Line Noise...

Distortion Correction

Repeat Project...
Project

Image Group

Analyze Peak Points

Analyze Equivalent Columns...
Distortion Analysis

Histogram from Spreadsheet
Show/Hide

Add Color Marker

Create Vector Map...

Show Ideal Positions

Help
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Getting Started

PPA for DM Manual

Image pre-processing and Basis Vector Selection

(Bragg Filter)

Open the file QuantumWire.dm3 using the DM command File...Open. The image below
represents a capped InAs quantum wire on GaAs. Composition was consi-dered to be uniform
inside the quantum wire and across the wetting layer.

E-;—_- F: QuantumWire
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All the commands related to PPA are located in the menu Peak Pairs. The first command to
be applied to a new image is the Power Spectrum command to calculate the power spectrum

of the image:

PeakPairs | Help

¥ Fourier Space Noise Filter
Real Space Noise Filter >
Non-Local Noise Filter > Wiener Filter...

Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference

Correct Scan Line Noise...

Strain Map...

l Power Spectrum I

té= D: Power Spectrum of QuantumWire




HREM Research Inc. PPA for DM Manual

Now, select the HREM mouse tool, and click on
desired spots to apply Bragg filter. The usual choice is to
select the brightest spots in the spectrum, but those
corresponding to higher harmonics can also be selected:

The user doesn’t need to hit the spot exactly, because
PPA looks for the local maxima near the selected point.

Anyway, if necessary, you can zoom in the spectrum
before hitting peaks using the DM zoom tool:

t-;: D: Power Spectrum of QuantumWire

Hint: if you wish to delete any spot,
just click on the mouse mark again
with the SHIFT key down.

Hint: Symmetry in the selection for
each spot is assumed.

IMPORTANT: First and second chosen spots (numbered as 1 and 2) will define the lattice
basis vectors. These spots should be apart from the vertical or horizontal of the central spot, in
order to obtain maximum resolution.

Don’t be surprised if the central spot is not present in the power spectrum. It just indicates that
the mean intensity of the image is zero.
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We are now ready to apply Bragg Filter. This process creates an image where the contrast
resulting from the ordered regions is clearly distinguishable from the background intensity.

PeakPairs | Help

Fourier Space Noise Filter » Power Spectrum

Real Space Noise Filter >

Bragg Filter X

Project Name:

[ Invert Peaks
[l Keep Mean Value

Non-Local Noise Filter >

Set Reference Base Vectors

Motif Detection >
Find Peaks >

Size:

Find Peak Pairs

Displacement Maps

Smoothing Width:
[l Oval Ratio:
Direction: degree

NOTE: If you are interested in black spots, the Invert Contrast will be checked.

Define Reference

The shape and size of the Bragg filter must be adjusted such that no loss of information occurs.
In this dialog box we can determine the size (in pixels), smoothing width (in pixels), oval axis
ratio and direction (in degrees) of oval masks. When you change any parameters, we
recommend you to check an actual mask shape by pressing the Apply button.

NOTE: When the check box for Oval Ratio is OFF, the parameters for the oval are not applied.

Let us select the window size as shown below and press the OK button, and the Bragg filtered
image will appear immediately.

= D: Power Spectrum of QuantumWire [e][=@]=]

i L: Projectl Bragg Filtered QuantumWire

2 ) ' ) s

If Bragg filter parameters are properly chosen for a sufficient number of peaks, the resulting
filtered image will preserve the location of maxima. The great advantage in using the filtered
image is the reduction of noise.
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Peak Detection (for a simple structure)

IMPORTANT: Peak Detection uses two base vectors information (unit cell) to find a set of
good intensity peaks. Thus, when the base vectors have not been defined yet, they should be
defined manually using the Set Reference Base vectors command.

NOTE: The Bragg filter or Wiener filter defines the two base vectors automatically.

Once we have a Bragg filtered image, the next step is to locate peaks of intensity in the image
by using the Find Peaks menu commands.

The first step of peak detection is peak identification based on their intensities. The Find
Peaks...Discriminate Peaks command detects all local intensity maxima in the image, and
calculates the histogram of peak intensities.

PeakPairs | Help
> Fourier Space Noise Filter >
Real Space Noise Filter
Non-Local Noise Filter

Set Reference Base Vectors

Motif Detection >
Find Peaks 3

Find Peak Pairs

Displacement Maps Remove Peaks

Define Reference Add Peaks

Here, we use Test image.dm3 as a sample data. First, we apply the Bragg filter using all the
spots in the Power Spectrum. When the command Discriminate Peaks is selected, a new
window showing the histogram of all the peaks found in the image will appear. The histogram
allows the user to locate different sets of peaks, based on their intensities. All peaks of intensity
lower than this threshold are discarded.

The Discriminate Peaks will also open the HREM Histogram control tool. If you want, you
can change the histogram range as well as the number of bins. The default range of the
histogram is set to the maximum and minimum of the peaks. When you change these values,
push the “Apply” button.

iz F: Peak Histogram of Project2 Bragg Filtered Test image [ @)=
2 T T
200 : - : HREM Histogram

180 Select threshold and press OK

Min: |1.2947 Max: |3.127

?
: :
% ( No of bins: | 100
g '
i
:

] '
2.705 -ok—o.«z —_—

TIPS: If you want to analyze black spots (hollows or dips), you have to check Invert
Contrast when you create a project.

10
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Once the histogram is shown, the user should select the intensity threshold for identifying which
peaks will be used in further analysis. To do so, just click the mouse on the histogram, and
select the desired range of peaks. The left side of the selection made in the histogram will be
used in the following Refine Peak Positions command.

ti= F: Peak Histogram of Project2 Bragg Filtered Test image IE[@
2

200:
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The discovered peaks will be classified to red or blue depending on the peak values: red
indicate the peak that is higher value than the selected threshold, while blue indicate the peak
equal to or lower than the threshold. The peak color will be dynamically revised by changing
the threshold (the left-edge of the Range ROI).

= H: Project1 Bragg Filtered Testimage [ o |[ & |3

HREM Histogram X
Select threshold and press OK

Min: |1.2947 Max: |3.127

No of bins: | 100

§ancel | | Home | | Apply
4

When you satisfy the threshold by looking the motif markers (red or blue), push the “OK”
button of the Histogram tool, or the “Cancel” button to stop the process.

11
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Once the range of peaks is selected, the next step is to refine the peak positions using the
Refine Peak Positions based on the intensity of the image.

PeakPairs | Help
Fourier Space Noise Filter »
Real Space Noise Filter >
Non-Local Noise Filter >

Set Reference Base Vectors

Motif Detection »

Find Peak Pairs
Displacement Maps

Define Reference

Discricai
Refine Peak Positions... >

Remove Peaks

Add Peaks

The following dialog box appears:

Find Peaks X

Using Intensity on

Original Image ~
Peak Threshold: [k

Typical Peak Width (FWHM):

FWHM: Full-Width at Half-Maximum
[l Show All Local Maxima

The image used to refine the peak positions can be selected from the images listed by
Using Intensity on.

Peak Threshold indicates the minimum intensity of a point to be considered as a
valid peak. Peak threshold value is automatically read from the left side of the selection
made in the histogram. However, the user can manually modify this value, if necessary.

Typical Peak Width indicates the size (FWHM) of the typical peak in pixels. The
peaks (columns) within this value will be merged into a single peak.

When Show All Local Maxima is checked, all the peaks at the local maxima is also
displayed in blue in addition the refined peaks (in red).

By pressing OK, we get a first set of peaks shown as colored spots over the filtered image. Blue
dots represent local maxima (8-neighbourhood) on a pixel basis. Red dots represent refined
maxima at sub-pixel resolution. Sub-pixel resolution is achieved by fitting a 2D quadratic
function and calculating the maxima, as described in the reference for the algorithm in the
Introduction section.

ject1 Bragg Filtered Test image =

Sometimes, extra peaks are obtained in this automatic Peak Finding process, especially at the
borders of the image. Repeating the Find Peaks command with a new Peak Threshold, all
peaks in the border of the image will be discarded and won’t be considered in any further
calculations.

12
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Motif Detection (for a complex structure)

In cases where the repeating unit in the image is more complex than a single column (dot), such
as a GaAs dumbbell, the peak (and thus the peak-pair) will be obtained for each unique column.
Thus, an alternative, more complex way to determine the lattice may be useful. Thus, the Motif
Detection has been implemented. Here, we explain the Motif detection using the image
QuantumWire.dm3.

First, a rectangle should be placed using the Rectangle ROI tool to defines the basic pattern
that will be searched across the whole image using normalized cross-correlation. For example,
in this image, a cation location (an upper part of a dumbbell) may be a good choice. Rectangle
size and location is a critical decision in the accuracy of strain results. Let us zoom in the
substrate, and select a rectangle area around a cation.

Once the rectangle ROI has been placed, select Motif Detection...Define Motif to determine
the Motif. Then, using the handles of the ROI, you can change the size of the Motif ROI, and
rotate the Motif ROI, if you want.

PeakPairs | Help
Fourier Space Noise Filter »
Real Space Noise Filter >
Non-Local Noise Filter »

Set Reference Base Vectors

Motif Detection » Define Motif
Find Peaks > Refine Motif using high x-Corr Patches...

Find Peak Pairs Discriminate Motifs...

Displacement Maps Refine Motif Positions...

Define Reference

TIPS: You can rotate the ROI by dragging the yellow cross (+). You can adjust one of the
edge lengths by selecting the yellow edge and dragging the handle. You can adjust both edge
lengths while maintaining their ratio when ragging the yellow cross with the SHIFT key down.

13
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Once the Motif has been defined, select Motif Detection...Refine Motif using high x-Corr
Patches. Here, x-Corr means Cross-Correlation. This command will refine motif using a high
score cross-correlation patches with the original motif. When you select this command, a dialog

shown below will open:

PeakPairs

Help
Fourier Space Noise Filter
Real Space Noise Filter
Non-Local Noise Filter

Set Reference Base Vectors

o
Find Peaks Refine Motif using high x-Corr Patches...

- - X i
Find Peak Pairs h

Refine Motif Positions...

Displacement Maps

Define Reference

x-Corr Histogram

Project Name: [M{J[Xeq]

[ Invert Contrast

Minimum Motif Distance:

[l Show Original Motif

After clicking OK, a new window will appear showing the histogram of all maxima found in
the Cross-Correlation map, obtained using the User-Selected motif and the whole image. At
the same time, the HREM Histogram tool will appear as shown below.

= P: Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire

(E=8Ee8

HREM Histogram
Select threshold and press OK

Min: | 0.5
No of bins: |200

Max: | 1.0

In this case, we may observe two peaks in the histogram, corresponding to Ga and /n cations
across the image. Once the histogram is shown, you should select the intensity threshold for
identifying which peaks will be used in further analysis. To do so, choose the Select tool and
click the mouse on the histogram. Then, move the left edge of the selection to define the

lower threshold.

T |
p ]
rUSS ‘-‘)QLHL-OMV

0.50 055 1.00

The default range of the histogram is set to 0.5 to 1.0. If you want, you can change the
histogram range (Min and Max) as well as the number of bins (No of bins). When you

change these values, push the Apply button.

14
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The discovered motifs will be classified to red or blue depending on their cross-correlation
values: red indicate the motif, whose cross-correlation value is higher than the selected
threshold, while blue indicate the motif equal to or lower than the threshold. The peak color
will be dynamically revised by changing the threshold.

¢ H: Project Bragg Filtered QuantumWire folfe==
] . M -

Given that we are interested in the detection of both cations, we will select a threshold lower
than 0.9 to take all peaks into consideration.

= P: Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire oo ==

P [ HREM Histogram X
l ] Select threshold and press OK

“ Min: | 0.5 Max: | 1.0
{ No of bins: |200
\r‘ d ; ( Eancel Home | | Apply

When you satisfy the threshold by looking the motif markers (red or blue), push the OK button
of the Histogram tool, or the Cancel button to stop the process.

If you push the OK button, the first refined motif is calculated by averaging |es=lclEd
all patterns associated to each point in the histogram above the chosen
threshold (0.91 in the figure). The averaged motif is automatically shown:

The third step of the Motif detection is calculating the cross-coefficients using the refined motif.
To do so, select Motif Detection...Discriminate Motifs command.

PeakPairs | Help

Fourier Space Noise Filter »

Real Space Noise Filter >

Non-Local Noise Filter >

Set Reference Base Vectors

Motif Detection > Define Motif
Find Peaks » Rafiae 4 fe==Corr Patches...

Find Peak Pairs Discriminate Motifs...

Displacement Maps

Define Reference

15
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Then, the histogram of the cross-correlation between the refined Motif and the whole image
will be shown. This step is especially useful in the presence of noise.

’I'.": T: Peak Histogram_X-corr of Refined Motif with QuantumWire

(E=8 o

o
2l

450

HREM Histogram X
Select threshold and press OK

Min: IT Max: IT
No of bins: W

@ [Cancel] [Home] [Apply]

Once the refined histogram is shown, the user should select the intensity threshold on the

refined histogram as before.

450

= T: Peak Histogram_X-corr of Refined Motif with QuantumWire oo ===

The discovered motifs will be classified to red or blue as before. The peak color will be
dynamically revised by changing the threshold. When you satisfy the threshold by looking the
motif markers (red or blue), push the OK button of the Histogram tool.

vz H: Project1 Bragg Filtered QuantumWire

[S=]r=]

16

HREM Histogram X
Select threshold and press OK

Min: |0.5 Max: |1.0

No of bins: | 200
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The final step of the Motif detection is finding the refined motif centers (positions) by using
quadratic fitting to the cross-correlation peaks. To do so, select Motif Detection...Refine Motif
Positions, which opens the dialog as shown below.

PeakPairs | Help

Find Motif Centers

Fourier Space Noise Filter >

Real Space Noise Filter > Peak Threshold: m

Non-Local Noise Filter >

Set Reference Base Vectors Minimum Peak Distance:
Motif Detection » Define Motif Show All Local Maxima

Find Peaks > Refine Motif using high x-Corr Patches...

Show stacked motif

Find Peak Pairs

Displacement Maps Refine Motif Positions...

Define Reference

If the motif peaks within the minimum motif distance are found, these peaks will be merged
into a single peak position.

Then, the refined motif positions (the centers of the motif boxes) are marked by the small red
boxes, and the second refined motif will be displayed. When Show All Local Maxima is
checked, all the peaks below the threshold are also displayed in blue. (Here, no blue boxes are
shown.

0
o B: Projl Bragg Filtered QuantumWire e o o=

Refined
motif

17
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Peak Pairs Determination

IMPORTANT: Peak Pairs are calculated using two basis vectors. The Bragg filter defines the
two base vectors automatically. However, when the two base vectors are not defined yet, they
should be defined manually using the Set Reference Base Vectors command.

Once all peaks or motif centers have been selected, Peak Pairs should be calculated using the
Find Peak Pairs command. This process will find all pairs of peaks along the predefined two
basis vectors.

PeakPairs HeIp ir3/H: Bragg Filtered Test image.

Fourier Space Noise Filter > ‘n' n p
> A

|

Real Space Noise Filter

Non-Local Noise Filter

A
Set Reference Base Vectors ! ﬁ‘

Motif Detection
»

Find Peaks '
Find Peak Pairs
Displacement Maps

Define Reference

Motif Detection (complex structure)

18
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Displacement and Strain Maps calculation

Once all Peak Pairs have been determined, we can proceed to the calculation of displacement
maps using the Displacement Maps command. This command generates horizontal and
vertical displacements (D1h, D1v, D2h and D2v) for the two base vectors.

% Q: Project1 D1h oo e | & projectio1v mEG
w3l T o

- A2 ¥ b 1B
P Pl

PeakPairs | qDPC Help

Fourier Space Noise Filter » i, A '.I ’
Real Space Noise Filter > -7
Non-Local Noise Filter 4

Set Reference Base Vectors

Motif Detection 4
Find Peaks 4
Fin

Displacement Maps )

Define Reference

Strain Map...

Correct Scan Line Noise...

Distortion Correction 4

Technical note:
PPA uses an automatic selection of contrast and the temperature color scale for displaying
image values. Default color range is +1 pixel.

If you prefer a grey scale or a different contrast limit, press the right button on the image,
and modify Image Display options properly (consult the DigitalMicrograph manual).

Changing this option will not change the actual values, only its appearance.

An essential step of strain determination is to define the Reference Area, the area that is
considered to correspond to the reference lattice, where we refine the base vectors. It is
important to note that the Peak-Pairs Analysis requires roughly determined base vectors to
find the peak-pairs and to calculate the displacement maps.

All displacements and strain values will be referred to this area. Use the Rectangle ROI
tool, select an area on any one of the Displacement images (D1h, D1v, D2h or D2v):

= Q: Projecti D1h === EcE [~

19
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Once the Rectangle ROI has been placed, the user should select the Define Reference
command. This will change the displacement values, so as to obtain a uniform displacement in
the chosen reference area. In some case, the displacement maps do not change so much even
when their values actually change, since the color maps range is automatically adjusted.

PeakPairs | Help

Fourier Space Noise Filter

= P: Project1 D1h [f=l-®-]@Ess | ¥: V: Project1 D1v B

Real Space Noise Filter
Non-Local Noise Filter

Set Reference Base Vectors

Motif Detection

Find Peaks Loz [=1(@ =] | & W: Project1 D2v C

Find Peak Pairs

Displacement Maps
Define Reference

Correct Scan Line Noise...

Strain Map...

The Define Reference command makes the Rectangle ROI rotatable. You can change the size
and angle as shown below, if you want:

R t=lo e You can adjust the edge length by selecting
the yellow edge and dragging the handle, and
rotate the ROI by dragging the yellow cross

().
You can adjust the both edge lengths by

dragging the yellow cross when pressing the
SHIFT key.

When you change the ROI shape or displace the ROI, the average displacement within the ROI
will be automatically set to zero.

The final step is to calculate strain maps (exx, €yy, €xy and eyx) at the desired angle. When the
Strain Map command is selected, the dialog below appears. Here, you can determine the
direction of the x-axes to display the strain maps using Angle of x-axis to horizontal. If the
angle is set equal to 0, horizontal direction corresponds to the x-axes.

& Strain Map ==

Option I

Find Peak Pairs

Displacement Maps

‘ Angle of x-axis to horizontal: | 7.5

Define Reference
Show the following images

Strain Matrix
() Independent

Correct Scan Line Noise...

Repeat Project...
Project »
Image Group » Cancel

@ Symmetric
[~ Mean Dilatation
[~ Rotation Angle

20
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The angle of x-axis to horizontal may be determined graphically. To do so, just put a Line
ROI on the original image along the desired direction of x-axis, and launch the Strain Map
command.

- F: QuantumWire

Once the OK button is chosen, a set of 4 images corresponding to (exx, €yy, €xy and eyx) will be
displayed when Independent is elected. When Symmetric is selected, ey is an average of
exy and eyx of the independent expression. The mean dilatation is an average of exx and eyy. and
the rotation is given by (eyx—exy).

There is an option for strain representation (Overlay):

DESCRIPTION Full image Detail

No O'Verlayz . e K: Projectl x| || @)
Continuous strain

maps are shown.

Hint: If you prefer a grey scale or a
different contrast limit, press the right
button on the image, and modify
ImageDisplay options properly.

|

Overlay: = G: Project] exx
Strain maps at
each atomic
column are
shown with color
dots over the
original images.

21



HREM Research Inc. PPA for DM Manual

Setting the Reference Base Vectors

It is possible to manually set the reference base vectors.

To manually define the Reference Base vectors, use the HREM Mouse Tool to select 3 points
in the order the origin of both vectors, terminal point of vector 1 and terminal point of vector 2,
so that the directions of the desired reference base vectors are described by the directions of

vectors 1->2and 1->3.

Approximate directions
specified by the user

When applying the Set Reference Base Vectors command, the dialog shown below will

open.
Set Reference Base Vectors %

Fourier Space Noise Filter >

Real Space Noise Filter 4 Project Name: [guiCey

Non-Local Noise Filter > M Invert Contrast

Set Reference Base Vectors Base Vector 1 (1->2) :l
e Vet 2159 ]
o

Normally, the reference base vectors along the user specified directions will be automatically
estimated using Auto-divide. However, if the unit is not simple, the algorithm to determine a
repeating unit will fail. In this case, you can specify the number of repeating units along two
directions. In this case, 5 and 6 along the base vector directions 1 (1->2) and 2 (1->3),

respectively.
NOTE: If you are interested in black spots, the Invert Contrast should be checked here.

Motif Detection | 2
Find Peaks >

22



HREM Research Inc. PPA for DM Manual

The precise magnitude and direction of both reference base vectors are calculated using a least-
squares fitting to all the peaks within the parallelogram defined by two vectors 1->2and 1->3.

[
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Other Noise Filters

Since the peak positions are often affected by noise, reducing the noise is very important for
strain measurement by the PPA. Thus, we have used the Bragg filter in the Getting Started
section. In this section, we will explain other noise filters available for the PPA plug-in, namely
the Wiener filter in Fourier space, and real space noise filters including non-local noise filter.

Fourier Space Noise Filters

Wiener Filter

While the Bragg filter is very useful to reduce noise, all the spots that pass the filter should be
selected manually to faithfully reproduce the original features. Furthermore, the noise inside of
a filter mask will not be blocked and contribute to a filtered image.

The Wiener filter is widely used for image restoration and calculates the optimal filter for
removing the noise. The Wiener filter selects significant spots (the peaks in Fourier space) over
the noise power automatically. This means you don’t need to select all the peaks to be included
for filtering.

NOTE: The Wiener filter of the PPA is the Radial Wiener Filter, which means the noise
power is estimated from rotational average of the power spectrum. This is the restricted
version of Wiener filter implemented in the HREM-Filters plug-in. Thus, you have to install
the HREM-Filters Lite (a freeware plug-in), or the HREM-Filters Pro (a commercial plug-in).
When none of them is not installed, the warning message shown below will appear:

DigitalMicrograph x

This command requires the HREM-Filters plug-in.

Please install the HREM-Filters Lite (a free version of HREM-Filters),
which can be downloaded at www.hremresearch.com.

However, some capabilities, indicated by (Pro only), require

the HREM-Filters Pro (a licensed plug-in).

At first, calculate the Power Spectrum, and place two mouse points on it to define the base
vectors in Fourier space. When the power spectrum is frontmost, select the Wiener Filter
command. Then, the dialog to determine the project name will appear:

PeakPairs | Help Wiener Filter

Fourier Space Noise Filter L4 Power Spectrum
Real Space Noise Filter » gq Filte ) Project1

W Ihvert Contrast

Non-Local Noise Filter 4

Set Reference Base Vectors “

NOTE: If you image has hollows (dips), not peaks, the Invert Contrast will be checked here.

TIPS: The Wiener filter command can be used without using the power spectrum. In this
case, however, the base vector in real space should be determined manually by using the Set
Reference Base Vectors command.
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When click OK, the dialog below will open, and a circle will be drawn on the Fourier
transform as shown below left. If you want, you can change the Display Mode between
Modulus (Amplitude) and Log of Modulus.

Filter Options X

Resolution: EX4] pix

Information Limit x Maximum Frequency

Remove High Frequencies outside the Information Limit
Smooth Edge By: x Information Limit
[l Show Background
[l Show Mask

@ Simple Radial Background (e.qg.. Kilaas)
O Advanced Radial Background (Pro only)

[l Enhanced background (Pro only) E x random (white) noise std
[l Trend Subtract (Pro only)
Fourier Transform Display Mode: Q) Modulus (Amplitude)
@ Log of Modulus

[l Upsampling (Pro only) by -

In the Filter Options dialog, some parameters with “(Pro only)” are applicable only when the
HREM-Filters Pro (a commercial plug-in) has been installed.

The first four parameters determine how high frequency noise is eliminated. Using the circle
on the Fourier transform you can tell the Wiener filter the highest frequency of the signal,
namely the information limit. Resolution and Information Limit are inversely related. If you
change one value, the other value will be changed. When the image is calibrated, you will see
a physical unit for Resolution. If not, the unit of Resolution is pix (pixels). When you know
the resolution of the micrograph in a physical unit or in pixels, you can directly input the
value for Resolution. Alternatively, you can input the value for Information Limit in terms
of the Maximum Frequency of the Fourier transform.

Resolution When you know the resolution of the micrograph in a physical unit
or in pixels, you can directly input the value here.
Information Limit: The Information Limit given by a fraction of the Maximum
Frequency of the image.
Update By clicking the Update button, you can verify the Information

Limit on the Fourier transform.
Remove High Frequencies outside the Information Limit
Smooth Edge by If checked, high frequencies will be smoothly attenuated over both
sides of the Information Limit by the Smooth Edge by.

Radial Background type: The choice of the type of Radial Background. HREM-Filters Lite
can use Simple Radial Background obtained by rotational average
of the intensity (e.g., Kilaas).

Advanced Radial Background that is available for Pro only is
superior to the Simple Radial Background.

Fourier Transform You can select the display mode of the Fourier transform between
Display Mode Modulus (Amplitude) and Log of Modulus.
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Real Space Noise Filters

While Bragg filtering is very useful to reduce noise, some researchers may prefer alternative
noise filtering techniques in real space. There are two alternative noise filtering commands:
Adaptive Wiener Filter and Low Pass Filter. Since the techniques have no way to determine
automatically the basis vectors, they should be determined manually by using the Set
Reference Base Vectors command

Adaptive Wiener Filter

The Wiener filter in real space assumes that if noise is present in the system, then it is considered
to be additive white Gaussian noise.

When selecting the Adaptive Wiener Filter on the front image, the dialog below will open. In
a typical Peak Pairs session, if Wiener filtering is desired, it is usually the first operation to be
applied to the original image. Then, the project name should be given.

PeakPairs | Help

Wiener Filter
Fourier Space Noise Filter >

Real Space Noise Filter A( Adaptive Wiener Filter...

New Prct

W Ihvert Contrast
Adaptive Average: x2+1 pixels
Noise Estimation: n x2+1 pixels

NOTE: If you peak is dark (black) over the background, the Invert Contrast will be
checked here.

Non-Local Noise Filter

Set Reference Base Vectors

Motif Detection
Find Peaks

The user should decide the sizes of the windows used for calculating the Adaptive Average
and the Noise Estimation.

If the standard deviation of the local area is small, then the pixel value will be replaced by a
local average. On the other hand, if the standard deviation of the local area is large, then the
pixel value will be retained. Thus, the pixel value of the filtered image will be between the
original value and the local average according to the local standard deviation.

The result of the Wiener filtering applied to Test image.dm3 is shown below. The insets show
enlarged parts.

Left: Orlglnal nght Wlener (Adaptive Average: 3, Noise Estlmatlon 3)
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Low Pass Filter

In order to generate a Low-Pass filtered image, use the Low Pass Filter command on the front
image. Then, the dialog below will open. If the low-pass filtering is the first operation applied
to the original image, the project name should be given.

PeakPairs | Help

Low Pass Filter X

Fourier Space Noise Filter >

¥

— New Pocct: [N

Non-Local Noise Filter {( Low Pass Filter...
_ W Ihvert Contrast

Set Reference Base Vectors

Radius(pixel):
o

Motif Detection
Find Peaks

NOTE: If you are interested in black spots,
the Invert Contrast will be checked here.

The strength of the filter is defined by the Radius of the mask in pixels. The new pixel value
will be a local average with a Gaussian weight (mask) of the defined radius. Thus, the larger
the radius, the stronger the filter. You can specify a radius of less than one pixel.

In the figures blow, the resulting images after the application of a Low-Pass filter to the original
image Test image.dm3 (lower left) with different radius are shown:

’ N

iz B: PPA Test 1 (o= =]

s -

.[=[@ ][ =] || g A: Project1 LPFof ... [= |[ @ |[ &1 ]

iz A: Projectl LPF of ..

=

Original image Low Pass Filtered Low Pass Filtered
(right-lower corner only) (radius: 0.8 pixels) (radius: 1.6 pixels)
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Non-Local Noise Filter (from v5.0)

This filter allows the user to obtain a single image from a sequence of images of the same
specimen, usually a time-series (TS), obtained by a scanning system such as Scanning
Transmission Electron Musicscape (STEM). In order to make the scan distortion during the
image acquisition negligible, an acquisition time of each scanning image should be small. Then,
each image becomes noisy due to an avoidable quantum noise. Furthermore, the images
obtained by a scanning system have some scanning noise, so called jitter. Therefore, a simple
rigid alignment over the time series will make an atomic peak blurred, and degrade resolution.

The non-local noise filter performs non-local averaging (NLA) over the time series based on a
concept of non-local mean (NLM). Thus, the NLA over the time series is one of the non-rigid
alignments. The resulting image obtained by NLA reduces the scan noise without degrading
resolution and improves signal-to-noise (SNR) ratio (Barcena, 2016). This usually improves
peak location, which results in improved strain mapping.

The non-local noise filter has two steps: (i) Rigid image alignment and (ii) Image reconstruction
(non-rigid alignment).

1. The rigid image alignment estimates an average displacement of each image using the
cross-correlation between two images, and creates a new stacked image after correcting the
estimated displacements. Here, there are two modes of estimating the image displacements:
the image displacements between consecutive two neighbor images or between a fixed
reference image and other image.

ii. The image reconstruction performs non-local average over the rigid-aligned time-series
image, and gives a non-rigid aligned single image. For medium/large size images, Non-
Local-Average is very time consuming, and its calculation may take minutes or even hours
in a standard workstation. For this reason, we provide the NLA mode to use a NVIDIA
GPU for intensive calculation.

Here, we use the image series, Inds_QD Seriesl.dm3 (courtesy of Prof. David Gonzélez,
Universidad de Cadiz).

B:InAs_QD_Series1 - 0O X
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M oganicogeen s mscoseiet Once loaded, the user may navigate across different images of

I e the time-series using the standard GMS tool called Slice
(Slice Player) tool. Scrolling the cursor to the left allow the
selection of the first images in the series, and scrolling it to the
right, the last ones.

Display v & X

Image Status

Display Control

Control

Slice When scrolling this data, the user may observe the sample drift
over the time series.

Slice: 5

TIP: If the drift is not visible, zooming in the image to show a
partial area may help.

Width: 1/9

M Display Center

TS (Time-Series) RIGID ALIGMENT

The first step for applying the non-local noise filter is the rigid alignment. To do so, select the
Non-Local Noise filter...TS Rigid Alignment, where TS means Time Series.

PeakPairs | Help

Fourier Space Noise Filter

Real Space Noise Filter >

Non-Local Noise Filter >

Set Reference Base Vectors

After selection, the dialog shown below appears, where the user can choose all the options
available for Rigid Alignment:

Rigid Alignment X

Rigid Alignment [sIEIEN

Reference Image: m M fixed

Cross correlation

(VR Square RootModuli ~
Mask: <0.5 (Nyquist frequency)

Il Hanning Window

Peak search

Size: x2+1 pixels
00 |

Threshold:

M Trend Subtract

O No Crop

Output region: @ Crop to Common Area

O by Pixel
Alignment mode
@ by Sub-pixel

Reference Image

This dropdown menu allows the user to choose the Reference Image. When the
fixed checkbox is not activated, the image displacements between the consecutive
two neighbor images will be estimated downward starting from the selected
Reference Image, and then upward from the Reference Image. In this case, the
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choice of the Reference Image is not so important, since only two image
displacements depend on the selected the Reference.

However, when the fixed checkbox is activated, all the remaining images will be
aligned to the selected Reference Image. In this case, the choice of the Reference
Image is important, since all the image displacements depend on the selected
Reference.

Cross correlation

Here, the user selects three important features that control the cross-correlation
performance.

Mode: specifies the cross-correlation algorithm. There are three possible options:
Conventional: cross-correlation with normal amplitudes.
Square Root Moduli: cross-correlation with square root amplitudes
Phase Only: cross-correlation with unit amplitudes (only phase will be retained)

Mask: Specifies the radius of a low-pass filter in Fourier space (relative to the
Nyquist frequency) to eliminate high-frequency noise. Its value should be between
0to 0.5.

Hanning window: When checked, a Hanning Window will be applied before taking
the cross-correlation to reduce the effect from intensity discontinuity at the image
boundary.

Peak Search
Search conditions for the cross-correlation peak.

Size: Radius of the cross-correlation peak.

Threshold: Intensity below this level will be ignored when estimating a peak center.

Trend Subtract
If checked, a trend (slowly varying feature) is subtracted before alignment to
enhance the image feature.

Output region
Output region of the aligned image will be specified here. If the ROI is not present,
“Crop to ROI” is disabled.

Alignment mode

Here, the user can choose the way to determine the image displacement from by
Pixel and by Sub-pixel. When the alignment mode is by Pixel, the estimated
displacement is rounded into an integer (pixels) and no interpolation of the intensity
is performed. On the other hand, when the alignment mode is by Sub-pixel, the
image is shifted by estimated amount using Fourier transform.
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After choosing the options and pressing the OK button, two different windows are
automatically created: one shows the estimated displacements and the other the cross-
correlation values.

L:SpecimenDrift - 0O X K: Cross-Correlation - 0O X

pixels

-10
-15
-20
-25
-30
-35

30 0.14
25
20
15
10
5
0
-5

] 1 2 3 4 5 6 7 8 2 4 6

Specimen drift window Cross-correlation window

Specimen drift window shows the estimated drift of each image in pixels with respect
to the Reference Image. The blue and red lines correspond to drift in the horizontal and
directions, respectively. In this case the Reference Image is set to zero (0).

Cross-correlation window shows the cross-correlation values between two neighbor
images or between a fixed Reference Image and other image.

When the image displacements are estimated, the aligned image will appear in a new window
as shown below:

I A: inas QD _Series1_Align =

The aligned image consists on the images aligned with respect to the Reference Image.
If the aligned image stack is scrolled using the Slice Player, it may be observed that the drift
has been substantially reduced/removed from the series.

The red rectangle represents the common area where the series has valid values over all
images. The greater the drift, the smaller the common area and vice versa.
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TS (Time-Series) NON-LOCAL AVERAGE

Non-Local Average (NLA) of the time-series is the additional module for the PPA, which
requires a separate license. However, the script version that works without a license is provided
to evaluate the functionality of the NLA module. Since the script version takes almost a few
thousands of times of the GPU version of the NLA module, please use the script version only
for a small image or a small area defined by a rectangular ROL.

The second step of the non-local noise filter is the non-local average. To do so, select the Non-
Local Noise Filter...TS Non-Local Average, when the rigid aligned image is the front most.

PeakPairs | Help

Fourier Space Noise Filter >

Real Space Noise Filter >

Non-Local Noise Filter 4 Rigis =1

Set Reference Base Vectors TS Non-Local Average...

e as .

After selection, the dialog shown below will appear, where the user can setup all the options
available for Non-Local Average.

Non-Local Average X

Use Images
@ Allimages

O Images From _ To m

Reference/Feature Area

The pattern within this area defines the feature
to be searched over the Target/Search area.

width: FJJJ| 21 Height [ x2+1
(max:255) (max:255)

Target/Search Area

Similarity to the Reference/Feature area
will be examined over this area.

width: EJjJj 21 Height [ x2+1

(max:255) (max:255)

Similarity Control Parameter

Noise std x

A smaller value corresponds to higher similarity.

Compute Version

@YVl GeForce GTX 1650 with Max-Q Design ~ ~
O CcPU

@ Script

[ Display Mean Image
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Use Images:

This option gives the user the possibility to select a range of images to be used for
non-local averaging. This is useful when some first (or last) images of the time-
series are anomalous (blurred or distorted), or the user want to test the parameters
using the small number of images.

Reference/Feature Area:

The pattern within this area defines the feature to be searched over the
Target/Search area. The Reference/Feature area is defined by the rectangle box.
You may want to include a single peak of a few peaks in this box. If a larger area is
used, the fidelity of the similarity will increase.

Target/Search Area:

The Target/Search area is defined by the rectangle box. The similarity to the
Reference/Feature Area will be examined at each pixel over this area. The size of
this box should cover the magnitude of the scan jitter to perform non-rigid
alignment. Usually, the scan jitter is less than several pixels.

Similarity Control Parameter:

The similarity (S) between the Reference and Target areas is defined by the ratio of
the sum of squared difference (SSD) of intensities between the two areas to the
noise standard deviation (std), 0,,;se , multiplied by this parameter:

S = SSD /2(0,pise X this parameter)?

The contribution of the target area to the non-local average is set proportional to
e~5. Thus, a smaller value of this parameter gives stronger contribution of the target
area to the non-local average. Usually, the value of one (1) will work satisfactorily.

Compute version:

Here, you can choose the compute version from GPU, CPU and Script to be used
for non-local averaging. The calculation time will be dramatically reduced by using
the GPU, though it depends on the GPU characteristics (Core Count, Core Clock
Speed, Memory Type, Memory Size, Memory Bandwidth, etc.). However,
reductions times are usually in an order of (1/100) or even greater compared with
the CPU. Thus, we strongly encourage using GPU for Non-Local-Average
calculation.

NOTE: The selection for GPU becomes active only when you have the license for
the Non-Local Average module and the NVIDIA GPU is found on your PC.

NOTE: Even without the Non-Local Average license, you can still use Script
version to evaluate the functionality of the NLA module. However, the script
version takes almost a few thousands of times of the GPU version.

TIPS: You can stop the execution by pressing the SPACE bar at any time.

Display Mean Image:

Selecting this checkbox will display the average image, where each point in the
result image is simply the mean of the values at that point of the rigid aligned image.
This mean image is used as the reference image for the non-local averaging.
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L: InAs_QD_Series1_NLM - O X

H: InAs_QD_Series1_Mean - 0O x
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Advanced Topics

Find Weak Peaks (using Find Peaks)

Detecting weak peaks in the presence of the strong peaks is problematic. A STEM-HAADF
image is such a case, since the image intensity is roughly proportional to the square of atomic
number. If you set a threshold to a low value to detect weak peaks, some pixels around strong
peaks may be erroneously assigned as peaks due to noise. This problem may be circumvented
by repeating the Find Peaks to detect the peaks. This will be explained by using the simulated
STEM-HAADF image of InP [110] (zincblende.dm3).

The first trial of Find Peaks...Discriminate Peaks on zincblende.dm3 data (below left) gives
the histogram (below right). You can see two distributions of strong and weak peaks
corresponding to /n and P columns, respectively.

I B zincblende_110 - O x

I: Peak Histogram of Project2 zincblende_110 - 0

10

Using the threshold shown in the histogram you can detect all strong peaks of /n columns. When
you perform Refine Peak Positions, you will get the image shown below.

A: Project1 zincblende_110 - o
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Then, you can try again Find Peaks...Discriminate Peaks. At that time, you will get the small
dialog that requests you to input a radius of the circular mask in pixels:

DigitalMicrograph x

mask radius?

The pixels within the circular masks around the already found peaks will be excluded in this
step. When the dialog is opened, the default value is shown, which is an average of the peak
radius determined at the previous Refine Peak Positions. If you want, you can increase this
number to exclude more pixels around the strong (already detected) peaks.

Using the default mask radius, a new histogram will be shown. When some high intensity pixels
at image borders are not excluded by the mask, the Max value of the histogram tool will be
high as shown by the left histogram. In such a case, you can change the Max value to see the
peak shape of the histogram as shown below right. Then, a good threshold value can be easily
determined.

M8 K Peak Histogram of Projectd zincblende_110 - O x [ sPpeakHistogram of Project zincblende_110 - o ox

Using the shown threshold, all the weak peaks corresponding to P columns can be detected.
After performing the second Refine Peak Positions, you will get the image shown below.
Here, newly found peaks are marked in red, and previously detected peaks are shown in green.

8 C: Project3 zincblende_110 - O x
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Correct Scan-Line Noise

There are situations in which the scanning electron microscopy image is altered by the presence
of scanning errors, such as small beam deflections due to external electromagnetic fields, as
well as hysteresis effects during the ‘fly back’ between scan lines, that may severely distort
strain results from the STEM image. The presence of scanning errors may prodice annoying
stripes in the strain maps. In these cases, the option Correct scan line noise may be quite

useful.

In order to show how to use this option, let us calculate strain maps from the image
QuantumWire50Hz.dm3 in the usual way, as we did with QuantumWire.dm3 image in

previous section. Then,

we will get the Power spectrum as shown below:

= C: Power Spectrum of QuantumWireS0Hz on|=E) @

If we specify the lattice base vector (#1 and #2 as indicated), displacement maps shown below
may be obtained. As we may observe, a set of stripes is shown in these maps:

e P: Project1 D1h

= (@R | & v: Project1 D1v SE=)

s W: Project1 D2v = @[]

We can then add a Rectangle ROI in one of the Displacement maps (here,
the image D2h, the bottom left image).
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When pressing the Correct Scan Line Noise command to correct scan-line error, the dialog

below will open.

Displacement Maps
Define Reference

Strain Map...

Correct Scan Line Noise...

Disto! on

Repeat Project...

Project

pi Correct Scan ... =

Correct All Line
[ ok

][ Cancel ]

—
You can extend the reference area for the scan-line
correction from the very top to bottom lines, when

you check Correct All Line in the dialog.

' P: Project1 D1h

[=i=]==]

2 v: Projectt D1v

[===]

Unfortunately, in this example there is no perfect reference area from the top to bottom of this
image. Therefore, we have horizontal artefacts as clearly see in the images D1v and D2v.

The scan-line correction has a capability to merge multiple reference areas. Here, we use two
reference areas at the top left and the bottom right. Then, we can better perform the scan-line
correction as shown below. There is no appreciable artefact observed before.

= N: Project1 D1h

o (@ ][=] | & Q: Project1 D1v

Tz P: Project1 D2h
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Geometric Distortion Correction

All optical systems and scanning systems distort the images they form. If these geometric
distortions are reproducible, it is possible to eliminate them when the image taken from the
perfect crystal is available. This is valid not only for projector lens distortions but also for any
other systematic distortions present in the image.

In order to correct the distortions, at first, we have to measure the distortions using an image of
a perfect crystal. We explain distortion correction here using a pair of images with the same
distortion, Test image.dm3 and Substrate.dm3, the latter of which corresponds to an image of a
perfect crystal.

Open the image Substrate.dm3, execute the Power Spectrum, and then Bragg Filter in the
usual way by selecting relevant spots in the Power Spectrum.

ﬁ" B: Substrate E@@ C: Power Spectrum of Substrate

Bragg Filter

HGTANETN S Project]|

[ Invert Peaks
W Keep Mean Value

Size:

50 |

0.1
Smoothing Width: i)
0.

[l Oval Ratio: -

Direction: EEYY]

Cancel

‘Then, calculate the Peak Pairs using the usual commands Find Peaks and Find Peak Pairs.
If we analyze the displacements with the Displacement Maps command, we can observe that
the image of a perfect crystal is distorted (they are not flat) as shown below right.
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Measuring Distortion using the Image of a Perfect Crystal

The distortion information can be obtained from the perfect crystal image, which then can be
used to correct distortions in any other image with the same image distortion. In order to obtain
the distortion information, select the project image with Peak Pairs information, and apply the
command Obtain Distortion Info. Then, dialog shown below will open. Here, you can simply
press OK in the dialog.

Motrbetection i’ Obtain Distortion Info x
Find Peaks »

) ) Rectify Image:
Find Peak P

l‘n cak e The lengths and angles of the refined base vectors
DR e shown in the parentheses differ from the expected
Define Reference unit cell, you can input the ideal values in the text boxes.
Strain Map... Then, the distortion information corresponding to

the ideal base vectors will be obtained.

Correct Scan Line Noise...

istorti i . . Base Vector 1
S e > Obtain Distortion Info...
Repeat Project... Apply Distortion Info... LT il
Project » aGle| (5 -135.1 (-135.117)
Image Group » -

Base Vector 2

Angle: IS (135076)

NOTE: Using this command, any distortion of an image obtained from a
perfect crystal can be corrected, when you input the expected lattice
information here (see Image Rectification section below).

Then, the distortion corrected image, named “<image name>_corrected”, will be displayed in
a new window as shown below.

N: Substrate_corrected - O X

This Substrate corrected image has distortion information inside, and can be used in later
analysis of the image affected by the same distortion. Therefore, you may want to save this
image to a disk with a distinct name (e.g., Distortion Info of Substrate) using Save As
command.

40



HREM Research Inc. PPA for DM Manual

Correcting Distortion using the Distortion Information

In order to correct another image with the same distortion using the distortion information, just
apply the Apply Distortion info. Then, the diagram shown below will open;

Find Peak Pairs Correct Distortion x

Displ; t M, .

Lz IEICCAER C: Testimage 256k v
Define Reference
Strain Map... |:> IEGHIGHENICH D: Substrate_corrected 256k v

Correct Scan Line Noise...

Distortion Correction 4

Obtain Di ion Info...
A e Apply Distortion Info... )
Project 4

Here, the Target Image is the image to be corrected, while the Distortion Info is the image
created by the Obtain Distortion Info command. In this case, we use ‘Test image.dm3’ as
Target Image and ‘Substrate corrected.dm3’ obtained from Substrate.dm3 as Distortion
Info image. By pressing OK, the new image (<image name>_corrected) will be created, where
all the distortions estimated from the perfect crystal image have been eliminated.

We can now proceed to analyze the distortion corrected image in the usual way to get the final
strains. The strain maps before and after distortion correction are shown below left and right,
respectively. The expected strains are reproduced by correcting the distortion.

. - - - <
iz J: Project2 exx = L: Project2 eyy (o] ®]|[=] e W: Projectd exx | o || @ |[ 2] | g Y: Projects eyy [a]l®]|[=

[=[@]C=]

d- M: Project2exy [ o |[ @ ][ 2] | g O: Project2 eyx = Z: Project4 exy [o][@ ][ =] | ¢ AB: Projectdeyx [ o |[@ |[ =]

before correction after correction

If we plot a horizontal profile across exx and a vertical one across eyy, we get the expected
results (exx=0.1 and eyy=0.05), which become flat after distortion correction.
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= D: Profile Of Project4 exx [=-J-E-)EEs] | i G: Profile Of Project4 ey o [@ =

o.

on
010
005
008
007
006
005
00+
003
002

001

ooo) ool
Image Rectification
When we know that the image 1s taken from a Obtain Distortion Info .
perfect crystal, we can get a rectified image using —
. . . . . ecuty Image:
the peak-pairs information and the information of The lengths and angles of the refined base vectors
the sample To do so. we can use the dlalog that shown in the parentheses differ from the expected
. ? unit cell, you can input the ideal values in the text boxes.

appears when Obtain Distortion Info command is Then, the distortion information corresponding to
launched the ideal base vectors will be obtained.

Base Vector 1

Length: m (8.49408)
PRule| 5N - 135.0 (-135.117)

Base Vector 2

Length: m (8.47219)
Angle: ESD)

Here, the lengths and angles of the base vectors used to calculate the displacement maps will
be shown in parentheses. If the values in the parentheses differ from the values expected from
an ideal unit cell, you can change the values accordingly. Then, by pressing OK, the distorted
image is rectified using the local distortions at each point of the image. We can verify this, by
calculating the displacement maps from the rectified image. Then, we observe that distortions
have been corrected as shown below left:

v AC: Project5 D1h [ o [ @ |58 | | gic AF: ProjectsDIv [ o |[ @ |[ ] = V: Project4 D1h o @[] | g Y:Project4 DIv [ |[-E- |3
L e —— - ————

o AE: Project5 D2h - [ |[@ [ 52 | || - AG: Project5 D2y [roon|[-E)- ][5 e X: Project4 D2h o (@[] | g z: Project4 D2v =) 52

after correction before correction
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Distortion Analysis (from v4.0)

From information on the peak positions of a complex structure, you can analyze a peak distance
and angle (a length and angle of the peak-pair vector). Furthermore, in principle, you can
calculate a rotation of a structural unit (e.g. tetrahedron or octahedron), or even a distance from
the ideal/virtual position to the observed peak. However, such an advanced analysis requires
some skill in programing. The Distortion Analysis of the PPA will provide an easy way to
perform such an analysis using the DM script.

For the Distortion Analysis, firstly perform Motif detection, and Find Peak Pairs. On the
other hand, write a script to measure distortions in the script window as shown below:

'S ~

; (=& =]

o
>

PPABeginDZ ()
{

// BAlways use this function at the beginning

// Calculate the vector from an ideal position

image VirtualPeak := (PPAPeak(l)+PPAPeak(2)+PPAPeak(3)+PPAPeak(4))/4
image displacement := PPAPeak(5) - VirtualPeak

<

PPASaveResult ( gIdeal Positionh,
PPASaveResult( gDisplacementh,
PPAPrepArrow( gDisplacementh,
PPAPrepColorMap( gDisplacementh,

[=
O W m -], b W

11 PPAFinishDA ()

/ Always use this

=
N

I

VirtualPeak )

displacement )
displacement,

PPAPeak (5) )
distance (displacement),

function at the end

[ Save ” Save As... ]

PPAPeak(5) )

»

NOTE: This script will measure a distance from the virtual position (the center of the
four peaks from peak #1 to peak #4) to the observed peak #5, and save some information
for a later use. Here, the functions with the prefix of PPA are provided with the PPA
plug-in v4.0 or later and explained at the end of this section.

TIPS: If you have no error messages, you may want to save the script for a future use by
clicking Save As... button. As you see the example script, you have to respectively use
PPABeginDA() and PPAFinishDA() at the beginning and the end of the script in addition

to your analyzing code.

The following shows the submenu for the Distortion Analysis.

Analyze Equivalent Columns...

Distortion Analysis »
Histogram from Spreadsheet
Show/Hide 4
Add Color Marker

Create Vector Map...

Measure Distortion...
Show Motif Positions...
Show Arrows...

Show Color Map...
Update Front Image...

Distortion Correction »
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Measure Distortion

The first step of the Distortion Analysis is to measure distortions using a script tailored to
your purpose. To do so, firstly, place a rectangle ROI to define the area to be analyzed on the
original image, and select the peaks to be used in the analysis using the HREM mouse on the
original image, the project image or the refined second Motif. Then, put the project image at
the front most, and run the script written in the script window. or launch the command
Measure Distortion to run the saved script.

When you launch the Measure Distortion command, the dialog shown below will open:

E% MeasureDistortion X

Select Evalustion Script | ...tAnalysis¥TestMean.s
Qutput Spreadsheet Name:

| Quantumwire_s51
Find Peaks within | 5.0 pixels

OK Cancel

Here, you can select one saved script file to evaluate distortions, and specify the output
spreadsheet name.

NOTE: When you directly execute the script, you will have a dialog without the script
file selection.

Each peak of the motif will be searched within the circle with the radius defined by the value
in the Find Peaks within box. If the peak is not found within the specified region, you will
find NaN (not-a-number) in the spreadsheet.

When pressing OK on the Measure Distortion dialog, the dialog shown below will open,
where you can choose the image intensity to be used to find the peak positions from the
Original and Project Images, and you can select the image with the HREM Mouse points from
the Original, Project and the (refined second) Motif images.

i B 3%
[E oG

Using Intensity on

[Project Image ']

Use Mouse Points on

[Project Image v ]

[ OK ][ Cancel ]

When pressing OK on this dialog, the distortion analysis script will run, and the spreadsheet
will appear with the information saved by PPASaveResult() as well as the information of the
peaks corresponding to the mouse points.
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Show Arrows or Show Color Map

When the distortion information is saved as a vector or a scalar value using PPAPrepArrow()
and PPAPrepColorMap(), the measured distortion can be visualized using the commands
Show Arrows or Show Color Map. Lunching one of the two commands on the spreadsheet
will open the corresponding dialog below, where you can select the column to be displayed
and setup other display conditions.

E% Show Arrows X E%j Show Color Map X
Show Arrows for | testlarrow v Show Color Map for | testlcolormap v
X,y components v x |10 Display Type
(® Polygon
Show Motif Positions
(Ocirde  Radius [5  Pixel
OK Cancel

Display Range (Percentile)
Low |0 % High | 100 %
Show Motif Positions

OK Cancel

NOTE: When you select these commands on the project image, at first, the dialog to
select a spreadsheet will open, and then the dialog shown above will appear.

TIPS: You can modify the appearance of the map using the Update Front Image...
command, if the front-most image is an arrow or color map.

TIPS: You can check the positions of the approximate motif centers on the original image
using the Show Motif Positions command.

Description of the functions
PPABeginDA()

should be called at the beginning of the script
PPAFinishDA()

should be called at the end of the script

image PPAPeak( number n )
generates a list of column positions for the peak #n.
image PPALength( image vector)
calculates the vector length.
image PPALength( image pointl, image point2)
calculates the length of the vector (pointl to point2).
image PPAAngle( image vector )
calculates the vector angle, anticlockwise from the horizontal axis.
image PPAAngle( image pointl, image point2 )
calculates the angle of the vector (pointl to point2), anticlockwise from the horizontal axis.
image PPAAngle( image pointl, image point2, image point3)
calculates the angle between two vectors (pointl to point2, and pointl to point3),
anticlockwise measured from point2 to point3.

void PPASaveResult( string “name”, image result data )
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saves result_data with an identifier “name” to the spreadsheet.
if result _data is vector, its coordinates (x, y), length and angle (measured anticlockwise from
the horizontal axis) will be saved to the spreadsheet.

void PPAPrepArrow( string “name”, image vector data, image start_point)
saves the vector_data and the start point to the spreadsheet for an arrow map.
void PPAPrepArrow( string “name”, image angle, image start_point)
saves the unit vector with the specified angle and the start point to the spreadsheet for an
arrow map.
void PPAPrepColorMap( string “name”, image scalar_data, image display point)
saves the scalar data and the display point to the spreadsheet for a color map.

Sample code
PPABeginDA()

// calculate the vector from an ideal position

image VirtualPeak := (PPAPeak(1)+PPAPeak(2)+PPAPeak(3)+PPAPeak(4))/4

/I Here, we define the image “VirtualPeak™ to which the center of the four peaks saved.
image displacement := PPAPeak(5) - VirtualPeak

PPASaveResult( “Ideal Position”, VirtualPeak )

PPASaveResult( “Displacement”, displacement )

PPAPrepArrow( “Displacement”, displacement, PPAPeak(5) )

//calculate angle between two vectors Peak(5) to Peak(2), and Peak(5) to Peak(1)
image angle := PPAAngle( PPAPeak(5), PPAPeak(2), PPAPeak(1) )
PPASaveResult( “Angle”, angle )

PPAPrepColorMap( “Angle”, angle, PPAPeak(5) )

PPAFinishDA()

Another sample code

PPABeginDA()

/I Here, we define the image “peakn” to which the coordinates of the peak #n is saved.
image peakl := PPAPeak(1)

image peak2 := PPAPeak(2)

image peak3 := PPAPeak(3)

image peak4 := PPAPeak(4)

image peak5 := PPAPeak(5)

// calculate the vector from an ideal position

image VirtualPeak := (peak1+peak2+peak3+peak4)/4

// Here, we define the image “VirtualPeak” to which the center of the four peaks saved.
image displacement := peak5 - VirtualPeak

PPASaveResult( “Ideal Position”, VirtualPeak )

PPASaveResult( “Displacement”, displacement )

PPAPrepArrow( “Displacement”, displacement, peak5 )

//calculate angle between two vectors Peak(5) to Peak(2), and Peak(5) to Peak(1)
image angle := PPA Angle( peak$5, peak2, peakl )

PPASaveResult( “Angle”, angle )

PPAPrepColorMap( “Angle”, angle, peaks )

PPAFinishDA()
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Analyze Peak Points

The Analyze Peak Points command applied on the project image, such as Bragg filtered
image, will generate an output in spreadsheet including the following information (one row for
each lattice peak) that are already evaluated:

- Peak position at sub-pixel resolution (x,y coordinates)
- Peak intensity
— Strain tensor at each peak points (exx,eyy,exy and eyx): only after Strain Analysis.

Distortion Correction 4 =

¢ D: Lattice Points of Project3 Bragg Filtered PPA Test 1 =2
) £ I3 Height axx avy axy. ayx -
Repeat Project... mean |237.574 238.692 2.82694 0.0279326 | 0.0146443 | -0.00534172|-0. 00987758 |
. std_[137.592 136.723 0.119333  |0.0480278 |0.0317812 |0.0146783 |0.0149231
Project » P1_|6.72518 11.8867 2.68881 0086703 |-0.0428194 |0.0263026 | 0.0260612
P2 [7.13892 241.753 2.852 -0.0333832 |0.0203174 | -0.01035 | -0.00851274
Image Group 4 P2 |7.14498 229.672 2.81462 -0.0407684 |-0.00025249)0.00138291 |-0. 00871415
B P4 7.20826 205.77¢ 2.7538 -0.030673 -0.0076317 | -0.00267347|-0.0151094
Ana'yze Peak Points fica 7.20914 217.882 2.79 -0.0375265 | -0.00326502|-0.00502334|-0.0186023
P 7.22218 279.178 2.848395 -0.0368814 | 0.0337605 -0.0101031 |-0.0231307
Analyze cquve olumns... P7_|7.22584 254,189 2.77886 00361018 |0.047856 | -0.0138327 | -0.0149577
P8 |7.28678 266.711 2.63983 -0.0338632 |0.042157 | -0.0012523 | -0. 0256778
Distortion Analysis » P9 |7.30935 193.864 2.91845 -0.033584 | -0.00427666| 0. 00582282 | -0.00279915
P10 |7.33798 291671 2.79103 -0.0386477 |0.0460276 | -0.0152384 | -0. 0136449
Histogram from Spreadsheet Prr |7.a1728 304. 227 2.75082 -0.039785 |0.0461599 | -0.0137371 |-0. 0260204
P12 _|7. 22404 181,897 2.89344 -0.033971 |0.0038351 |0.00115376 | -0.00858061
Show/Hide 4 P13_|7.5a168 169. 871 2.66301 -0.0433459 |-0.00104136] 0. 00535647 | -0.0108181
P14 _|7.58362 316693 2.73329 00416819 |0.0348251 | -0.0202497 | -0. 0268683
Add Color Marker P15 _|7.7027 157. 965 2.6661 00400217 |-0.00907148| 0. 00656087 | -0.00788249
P15 _|7.73623 329.073 2.66285 -0.042688 |0.0332012 | -0.0172725 | -0. 0306297
Create Vector Map... PI7_|7.87523 146. 064 2.76209 -0.0403106 |-0.007093350. 0125334 | -0. 00436709
o P18_|7.31922 341,448 2.85664 -0.0358251 |0.0306097 | -0.0253737 |-0.0389183
Show Ideal Positions 4 P19 |8.07366 353.783 2.82647 ~0.0327167 |0.0273665 |-0.0159979 | -0. 0378463
P20 |8.11374 134.204 2.6393 -0.0481512 | -0.0159224 |0.0173555 -0.00192639
Help » £21 8.2421 366.123 2.79355 -0.0347414 | 0.0316551 -0.0269653 |-0.0378794
P22 |8.40503 122. 458 2.681865 -0.0506372 | -0.0154673 |0.0143579 -0.00359978
P23 _|8.50753 378452 2.92367 -0.0339204 |0.0225894 | -0.0252833 | -0.0330471
P25 86783 110.58 2.73576 -0.0523373 |-0.000436920.0197727 | -0.00410889
P25 _|8.72908 390634 2.8968 -0.0420334 |0.0165246 | -0.0227335 | -0. 0380875
< r |

If you want to see visually the distribution of, say, the peak height, you can use the Histogram
from Spreadsheet command. When you select the command, a dialog will open, where you
can select the data to be displayed.

Distortion Correction » EEir=] 1
S|
Repeat Project...
Project »
Image Group 4 = [@]=]
Analyze Peak Points E=iE=] ]
E=E=]

Analyze Equivalent Columns...

» 70

Add Color Marker 0
Create Vector Map... ] *
4 40

Show Ideal Positions » N
Help » L 20

47



HREM Research Inc. PPA for DM Manual

Analyze Equivalent Columns

Once Peak Pairs have been located, it is possible to analyze atomic column positions. This is

very useful when there is more than one atomic column within a unit cell. For example, in the
case of [110] projection of /nP (the zincblende type materials), we can evaluate cation and/or
anion atomic columns. In order to do so, go through the following steps (on zincblende.dm3):

- Calculate Peak Pairs in the usual way [ v G: Zincblende 110 =<
b -

- Bring the original raw image to
frontmost.

- Choose the area of interest on the
original image using the Rectangle
ROI tool.

- Select atomic column(s) to be analyzed
using the HREM mouse tool. (Here,
we select a set of cation and anion
columns)

- Bring the project image with Peak Pairs | L c: sincblende_110 = ]

information to frontmost.

&= N: Project4 AWF of zincblende_110 o[- )

- Apply the Analyze Equivalent
Columns command

Distortion Correction »
Repeat Project...

Project >
Image Group 4

Anal
Analyze Equivalent Columns...
Distorti »

Histogram from Spreadsheet

Show/Hide »
Add Color Marker

Create Vector Map...

Show I|deal Positions 4
Help 4

48



HREM Research Inc.

Then, the dialog Analyze Equivalent Columns will
open.

In the Distance tab, the user will have the option to
select the column(s), from which the distance(s) to
other column(s) will be evaluated.

In the Angle tab, if there are more than three columns,
the user will have the option to select the column(s),
from which the angle(s) subtended by two neighbor
columns will be evaluated.

In the Option tab, you can set two options: 1) the group
number on the original image, 2) the coordinate
system of the column positions.

PPA for DM Manual

L

e

iz Analyze Equivalent Columns

Distance IAngIe | option |
M1 @2 O3
Distances from the checked point(s) to
other points will be evaluated.

[ OK ][ Cancel ]

4

S

==

gz Analyze Equivalent Columns

Distance Angle IOpﬁon]

£1 @2 O3

Checked point(s) will be a vertex of angle(s)
subtended by two other points.

[ OK ][ Cancel ]

Analyze Equivalent Columns X

Distance Angle

Group number on the image

Column coordinate: Q) Image origin (top-leff)

@ Motif origin (top-left)

When the OK button is pressed, all the columns in the selected area will be located in the image
as shown below. The group number will be added on the image according to the setting in the

Option tab.

i D: zincblende_110

Ve .

™. - .
*a

":'
% _

2
-
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Furthermore, the position and intensity of each column as well as the distances and/or angels
will be stored in a spreadsheet.

i U: Distance_zin... [-o |-G |[w23a] l
.

— :_-326442 iz AD: Peak_zincblende_110 (o @][=
stgd | 0.0886919 A1 v £r A2 Y2 P2 -
Posi |6. 36691 wean | 101.92 106. 428 |0.306528 | 104.036 112.408__|0.0830263 || |
Pos2 |6. 36616 ST | 44.1637  |44.1372  |0.00148186 |44. 1825 | 44. 1416 | 0.000641287
Posd |6.37164 Posi |35.7565  |43.9015  |0.310308 | 37.9353 | 49.8847 | 0.0832183
Posd | 6. 40395 Pos? |31.5958 | 56.2847  |0.305591 | 33.7563 | 64.273 00818131
Pos5 | 6. 38342 Posd | 27. 4461 72.7096  |0.30573  |29.6055 | 78.7041 0.0323192
Posh | 6. 34361 Posd |35.6923 | 95.4985  |0.304349 | 37.9096 101.507 | 0.0836382
Pos7 | 6. 37638 Poss | 31.543 109836 |0.307186 | 33.7247 115. 84 0.0841879
Posd | 6. 40828 Posé |39.8894  |81.0467  |0.30847 | 42.0676 | 87.011 0.0330656
Posd |6.374 Pos7 | 27.346 124.263  |0.30508  |29.5528 130.245 | 0.0826102
Pos1G| 6. 37056 Pos8 | 34.0382 | 66.6424  |0.305346 | 46.2168 | 72.669 0.0830897
< Posg |52.4108  |37.8367  |0.306119  |54.5877 | 43.8237 | 0.0837043

Posfg|48.2239  [52.2539 | 0.305862  |50.3818  |56.2473 | 0.0817484 | _

Aeavwvlan 2040 400 EAC A AAANd A A4 AAanc 400 EAT A AfANAEN

< » _I

If you want to see visually the distributions of quantities stored in the spreadsheet, you can use
the Histogram from Spreadsheet command. When you select the command, a dialog will
open, where you can select the data to be displayed. The histogram below shows the distribution
of distances:

MM 12
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Create Vector Maps

It is possible to a create vector map from two vector components, such as D1h and D1v. We
explain here the Create Vector Maps command using the displacement maps calculated from
Substrate.dm3, as shown below:

-

ti- Z: Project3D1h  [ioo|-@-[mS3a] | gz AC: ProjectaDiv. [o |[@ [ 2]

After launching the Create Vector Map command, select these two vector component images
of the associated vector map, say D1h and D1v, and press OK.

Analyze Peak Points iz Create Vector Map

Select two components

Analyze Equivalent Columns...

Horizontal: [O: Project3D1h V]
Distortion Analysis » Vertical: [R: Project3D1v ']
Histogram from Spreadsheet Arrow

Interval: | 16 pixels

Show/Hide » length Scale: [1.0
Ad (Length = Scale * Interval)
Color: R 100 % G |0 % B |0 %

Create Vector Map...
,

Show Ide,

[ s

Then, you will get a color map corresponding to the vector magnitude, where the arrows show
the directions and magnitudes of the vectors as shown below:

& K Vector iap =

The vector map here is a complex DM image, whose real and imaginary parts correspond
respectively to the Horizontal and Vertical images selected in the dialog.

51



HREM Research Inc. PPA for DM Manual

Show Ideal Positions

Using the base vectors refined for the reference area, the ideal lattice or the ideal equivalent
positions can be drawn on the original image or the project image. To do so, two submenu
commands shown below are provided. These commands require a rectangular ROI, within
which the ideal positions will be displayed.

Create Vector Map...
Show Ideal Positions 4 Lattice...
Help > Equivalent Points...

Show l|deal Positions...Lattice
When selecting this command, the dialog shown below will open:

Show Ideal Lattice X

Use mouse point
DIELIEVELE Original Image  ~

[M Create a duplicate image

This command requires a mouse point to specify the unit cell corner. When there is more than
one mouse points, you can select one mouse point from the pull-down list. Furthermore, the
image, where the lattice is drawn, can be selected from the original image or the project image.
If you want, the lattice is drawn on a duplicate image of the selected image.

Show Ideal Positions...Equivalent Points
When selecting this command, the dialog shown below will open:

Show Ideal Equivalent Points

Use mouse point

1 W2 FE3

DIEIEVELE Original Image  ~

Create a duplicate image

This command requires the mouse points to define the equivalent points. You can select the
equivalent points to be drawn by selecting the corresponding check boxes. Furthermore, the
image, where the equivalent ideal points are drawn, can be selected from the original image or
the project image. If you want, the equivalent ideal points are drawn on a duplicate image of
the selected image.

NOTE: This command will draw the equivalent points using the refined base vectors. Therefore,
these points may differ from the points determined by Find Peaks command.
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Appendix

Technical Note:

The results of the PPA package is the complete strain tensor defined as follows:

Strain values
6u au s au au

x Y
= s = L, e =

e = s €. =
oo Y oy Ca o " ox

Strain tensor:

I A N R N 11
ij 1. ¢ = s £ = > € = +
2| dx, ox o Y ey Y 20y ax
Mean dilatation :
1( du, auj :
L=——t+—L| LE. Al =3 EtE,
v Z(le. axj] Y 2( “y)

Rotation (in radians and anti-clockwise positive):

ou . S\
wi. =l i_% 1.€. w =l %_%
T2 ax, ox. o2l ax ay
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Some useful DM tricks

DM ROI tool:
Hint: to select a square area, hold ‘ | .
down SHIFT. To select powers of m k A Q A
- o
two, hold down SHIFT-ALT. - o @
£ Rectangle
" Line
=L .
Hint: to demagnify, press ALT. - SO
& Loop
' Ccurve
¢ Oval
HREM Mouse tool L
‘ m \I> \ Q A~ Hint: to delete any spot, just click
o, . E on the mouse mark with the SHIFT
Lo = key down.
DM Image Display Command
) Project3 exx o |[ & |3 el Projectl ek o | & =)

—

Hint: to change the color map of any
image, press the right mouse button
on it, select ImageDisplay, and
modify the options as desired.

For example, it is useful to set
manually the color range of each
5 map to be the same, so as to be able
to compare each other.

ImageDisplay...

Display Type
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Quick Reference Guide

The PPA Main Menu

PeakPairs | qDPC Help Power Spectrum
Fourier Space Noise Filter > Bragg Filter...
Wiener Filter...

Real Space Noise Filter »

Non-Local Noise Filter % Adaptive Wiener Filter...

Set Reference Base Vectors Low Pass Filter...

Motif Detection 2
Find Peaks 2

TS Rigid Alignment...

TS Non-Local Average...

Find Peak Pairs

Displacement Maps Define Motif

X Refine Motif using high x-Corr Patches...
Define Reference
Discriminate Motifs...

Strain Map...
+ Refine Motif Positions...

Correct Scan Line Noise...

Discriminate Peaks...

[

Distortion Correction »

Refine Peak Positions...
Repeat Project...

Remove Peaks
Project »

Add Peaks
Image Group >
Analyze Peak Points Obtain Distortion Info...
Analyze Equivalent Columns... Apply Distortion Info...
Distortion Analysis »

' Measure Distortion...
Histogram from Spreadsheet Show Matif Positions...
Show/Hide » Show Arrows...

Add Color Marker Show Color Map...
Create Vector Map... Update Front Image...
Show |deal Positions »
[~ .
Lattice...
Help > ) X
Equivalent Points...
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PPA for DM Manual

The commands in the PPA menu are described below.

Command

Description

Fourier Space Noise Filter
Power Spectrum |
Bragg Filter... ‘

Wiener Filter...

Reduces noise using Fourier space filter.

The power spectrum will be used to define the
base vectors in Fourier space (reciprocal space),
and to select the spots for the Bragg Filter. The
Fourier space base vectors will be converted to
the base vectors in real space

Real Space Noise Filter
Adaptive Wiener Filter...

Low Pass Filter...

Reduces noise using Real Space Filter.

Non-Local Noise Filter
TS Rigid Alignment... ‘

TS Non-Local Average...

Reduces noise using Non-Local Averaging over a
time-series (TS) data. This performs rigid and non-
rigid alignment.

Set Reference Base

Sets the reference base vectors manually on an

Refine Motif using high x-Corr Pg
Discriminate Motifs...

Refine Motif Positions...

Vectors original image or a noise-filtered image.
(see Dialog) Note: Bragg filter sets the reference base vectors
automatically.
Motif Detection Detects positions of the repeating units (motif: a
Define Motif group of peaks). This is useful for a complex

structure.

Note: Reference base vectors should be defined
beforehand.

Find Peaks

Discriminate Peaks...

Refine Peak Positions...

Remove Peaks

Add Peaks

Locates peak positions in an image. The peak
position is determined by fitting the intensity to a
quadratic function.

Note: Reference base vectors should be defined
beforehand.

Find Peak Pairs

Calculates pairs of peaks along two base vectors
automatically.

Displacement Maps

Generates a set of horizontal and vertical
displacements for each base vector.

Define Reference

Changes the displacement values, so as to obtain
a uniform displacement in the chosen area.

Note: The area should be selected using the ROI
tool on any one of the displacement maps.

Strain Map...

(see Dialog)

Calculates strain maps (exx,eyy,exy and eyx) at any
desired angle.
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Correct Scan Line Noise...

(see Dialog)

Corrects imperfect scan-line control (scan-line
noise) of the STEM scanning system using a
perfect area in the image.

Note: The area(s) should be selected using the
ROI tool on any one of the displacement maps.

Distortion Correction

Obtain Distortion Info...

Apply Distortion Info...

Eliminates systematic distortions present in the
image based on the measurement of an ideal
distortion-free image.

Repeat Project...

Generates strain maps and other outputs for the

(see Dialog) front most image by performing the same
process(es) of a selected project.
Project Menu to manage all the images corresponding to
Hide a particular project.
Show

Save

Save And Close

Close
Image Group Menu to close or save the images of a same
— group of a particular project, such as the
displacement maps, strain maps, etc..
Close

Analyze Peak Points

Generates a spreadsheet of data (peak position,
peak intensities, strain values) for each peak

Analyze Equivalent
Columns...
(see Dialog)

Analyzes equivalent column positions, as well as
the distances and angles between specified
columns. The independent column(s) will be
specified using the HREM Mouse tool.

Distortion Analysis

Measure Distortion...

Show Arrows...
Show Color Map...
Update Front Image...

Show Motif Positions...

Analyzes peak distances or angles of the peak-
pairs, or rotation angles of structural units (e.g.
tetrahedron or octahedron). The advanced
analysis can be performed using the DM script
that simply calls the functions provided by the
PPA.

Histogram from
Spreadsheet

Calculates a different histogram for each selected
column in the spreadsheet
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Show/Hide
Peaks
Peak Pairs
Peaks And Peak Pairs
Motif

Shows/hides a selected annotation on the image.
This command is useful when the image display
becomes crowded.

Add Color Marker

Adds a color bar with the low and high display
ranges. You can move the whole color marker or
change its size. You can move and edit them as
you like. The color marker can be moved outside
of the image display. You can rotate and flip using
Edit commands. (The ratio of the color bar is
fixed.)

Create Vector Map...

Create a vector map from two component images

(see Dialog) selected in the dialog.
Show Ideal Positions Shows the lattice or equivalent points based on
Lattice... the refined base vectors.

Equivalent Points...
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Power Spectrum

Bragg Filter...

Wiener Filter...

Component

Description

Power Spectrum

Calculates the Fourier transform of the front most
image, and displays the power at each frequency
(commonly called the Power Spectrum).

Bragg Filter...
(see Dialog)

Calculates the noise filtered image using the spots
selected on the Power Spectrum. The shape and size
of the mask can be defined by the user in the dialog.

Note: Spots should be selected beforehand on the
Power Spectrum using the Mouse Tool.

Note: The first and second spots defined the base
vectors in Fourier (reciprocal) space, that are
converted to the base vectors in real space,.

Wiener Filter...
(see Dialog)

Calculates the noise filtered image using the Wiener
filter, where the background is estimated by the radial
average of the power spectrum.

NOTE: The base vector can be defined by the two
mouse points on the Power spectrum.

NOTE: This command requires the HREM-Filter Lite
(free plug-in) or the HREM-Filters Pro.

Braqq Filter Dialog

The components of the dialog are described below.

Dialog

Bragg Filter X

Project Name:

[ Invert Peaks
[l Keep Mean Value

Smoothing Width:

[l Oval Ratio:
Direction: degree

Size:

Small v

Component

Description

Project Name

Name given to the group of images and results
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Invert Contrast

If you want to analyze the hollows (dips), not peaks,
you should check this item.

Keep Mean Value

If checked, the mean value of the original image will
be kept. Otherwise, the mean value will become zero.

Size Defines mask radius in pixels.

Smoothing Width Specifies mask smoothing width in pixels

Oval Ratio Defines the shape of the oval, as major to minor axis
ratio

Direction Sets the direction of the major axis of the oval in

degrees

Wiener Filter Dialog

The components of the dialog are described below.

Dialog

Filter Options X

Resolution: EXY) pix

Information Limit: x Maximum Frequency

Remove High Frequencies outside the Information Limit
Smooth Edge By: x Information Limit
[l Show Background
[ Show Mask

@ Simple Radial Background (e.g.. Kilaas)
O Advanced Radial Background (Pro only)

[ Enhanced background (Pro only) I:I x random (white) noise std

[l Trend Subtract (Pro only)
Fourier Transform Display Mode: Q) Modulus (Amplitude)

@ Log of Modulus
[l Upsampling (Pro only) by -

Cancel

Component

Description

Resolution

Put the resolution of the micrograph in a physical unit
orin pixels. Since the resolution may not depend on
the magnification, it is convenient to use this when
the image is calibrated.

Information Limit:

Set the Information Limit given by a fraction of the
Maximum Frequency of the image.

Update

By clicking the Update button, you can verify the
Information Limit on the Fourier transform.
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When you change the value of the resolution or
information limit, click this button to check the size of
the circle on the power spectrum.

Remove High Frequencies outside the Information Limit

Smooth Edge by

If checked, high frequencies will be smoothly
attenuated over both sides of the Information Limit
by the Smooth Edge by.

Show Background: If checked, the background of the Wiener filter will be
displayed.

Show Mask: If checked, the Wiener/Difference filter mask will be
displayed.

Radial Background
type:

The choice of the type of Radial Background. The
HREM-Filters Lite can use Simple Radial Background
obtained by rotational average of the intensity (e.g.,
Kilaas).

Advanced Radial Background that is available for Pro
only is a smooth version of the Simple Radial
Background. Usually, this advanced background is
far superior to the Simple Radial Background.

Enhanced background
(Pro only)

If checked, the background is increased by the factor
multiplied by the std of the random noise.

Trend Subtract (Pro
Only):

If checked, the trend of the original image is
subtracted before Wiener filtering, and put back
afterward.

Fourier Transform
Display Mode

You can select the display mode of Fourier transform
between Modulus (Amplitude) and Log of Modulus.

Upsampling (Pro only)

If checked, the filtered image will be up-sampled by
the selected factor.
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Adaptive Wiener Filter...

Low Pass Filter...

Component Description

Adaptive Wiener Filter... | Removes noise from the image using an adaptive
(see Dialog) Wiener filter in real-space based on a local variance.
Low Pass Filter... Applies a Low Pass filter in real-space to the image,
(see Dialog) which is a weighted local average of the image.

Adaptive Wiener Filter Dialog

Dialog

Wiener Filter X

New Project:

W Ihvert Contrast
Adaptive Average: x2+1 pixels

Noise Estimation: x2+1 pixels

Component

Description

New Project

Name given to the group of images and results.

Invert Contrast

If you want to analyze the hollows (dips), not peaks,
you should check this item.

Adaptive Average

Defines a square area to be used to calculate a local
average.

Noise Estimation

Defines a square area to be used to estimate a local
noise power.

Low Pass Filter Dialog

Dialog

Low Pass Filter X

New Pt

Il hvert Contrast

Radius(pixel):
o]

Component

Description

New Project

Name given to the group of images and results.

Invert Contrast

If you want to analyze the hollows (dips), not peaks,
you should check this item.

Radius (pixel)

The radius of the mask in pixels
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TS Rigid Alignment...

TS Non-Local Average...

Component Description
TS Rigid Alignement... Estimates an average displacement of each image
(see Dialog) using the cross-correlation between two images, and

creates a new stacked image after correcting the
estimated displacements.

TS Non-Local Average...
(see Dialog)

Performs non-local average over the rigid-aligned
time-series image, and gives a non-rigid aligned
single image.

TS Rigid Alignment Dialog

The components of the dialog are described below.

Dialog
/Alignment Tab

Rigid Alignment X

Rigid Alignment [slEHsIEN

Reference Image: m M fixed

Cross correlation

"6l Square RootModuli  ~
Mask: < 0.5 (Nyquist frequency)

Il Hanning Window

Peak search

Size: x2+1 pixels

Threshold: m

B Trend Subtract

O No Crop
Output region: @ Crop to Common Area

()

O by Pixel

Alignment mode:
@ by Sub-pixel

Component

Description

Reference Image

Select a slice number of a good image to start
alignment. The cross-correlation will be evaluated
between two consecutive images downward starting
with the reference image, and then upward.
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If “fixed” is selected, however, all the cross-
correlation will be evaluated with the selected image.

Cross Correlation

Mode

Cross-correlation mode will be selected from:

Conventional: normal cross-correlation using Fourier
transform coefficient.

Square Root Moduli: cross-correlation using square-
root of the amplitudes and the phase of the
Fourier transform.

Phase Only: cross-correlation using only phase of the
Fourier transform (amplitude is set to unit).

None: no alignment will be done.

Mask

Specifies the radius of a low-pass filter in Fourier
space (relative to the Nyquist frequency) to reduce
high-frequency noise.

Hanning Window

When checked, a Hanning Window will be applied to
the image before Fourier transform.

Peak Search

Search conditions for the cross-correlation peak.

Size

Radius of the cross-correlation peak.

Threshold

Intensity below this level will be ignored when
estimating a peak center.

Trend Subtract

If checked, a trend (slowly varying feature) is
subtracted before alignment to enhance the image
feature.

Output region

Output region will be specified here. If you want, you
can crop the result to the Common Area or to the
ROI. When the ROl is not present, “Crop to ROI” is
disabled.

Alignment mode

By Pixel: the estimated image shift will be rounded,
and no interpolation is performed.
By Sub-pixel: the image will be shifted by the

estimated image shift using the Fourier transform.

Diaplay Tab

iz Rigid Alignment & |

Rigid Alignment Display
(V] Cross Correlation
(V| Specimen Drift
(V| Cross Correlation Stack

| Component

| Description
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Cross Correlation

Displays cross correlation values between adjacent
images, or the fixed image.

Specimen Drift

Displays specimen drift values relative to the
reference image.

Cross Correlation Stack

Displays 2D cross correlation maps.

Message level

Controls the amount of output messaging to the
Results Window. (Minimum/Normal/Detail)

TS Non-Local Average Dialog

The components of the dialog are described below.

Dialog

Non-Local Average X

Use Images
@ Allimages

O Images From To m

Reference/Feature Area

The pattern within this area defines the feature
to be searched over the Target/Search area.

Width: x2+1 Height | x2+1
(max:255) (max:255)

Target/Search Area

Similarity to the Reference/Feature area
will be examined over this area.

Width: x2+1 Height B x2+1

(max:255) (max:255)

Similarity Control Parameter

Noise std x

A smaller value corresponds to higher similarity.

Compute Version

(@YWl GeForce GTX 1650 with Max-Q Design -

O CPU
@ Script

[W Display Mean Image

Component

Description

Use Images

The images to be averaged will be specified here.

Reference/Feature Area

The size of the feature (reference) area will be
specified here in pixels.

Target/Search Area

The size of the search (target) area will be specified.
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Similarity Control
Parameter

The similarity (SSD: sum of squared difference)
between the Reference and Target area is evaluated
by dividing the standard deviation (std) of the noise
distribution multiplied by this parameter.

Compute Version

The compute version can be selected here. If the
user has the NLA (non-Local Average) module
license and any NVIDIA GPU is found on your PC,
the GPU becomes active. In this case, you can select
the GPU from the pull-down list.

If the user has the NLA module license, the CPU
becomes active.

Even when the user does not have the NLA module
license, the Script can be selected.

Display Mean Image

If checked, a simple mean image over the aligned
stack will be displayed.

Set Reference Base Vectors Dialog

Dialog Set Reference Base Vectors .
Pt Nane:
[l Ihvert Contrast
e Vecar 1 (12 ]
e Vectr 2153 -
Component Description

Project Name

Name given to the group of images and results

Invert Contrast

If you want to analyze the hollows (dips), not peaks,
you should check this item.

Base Vector 1 and 2

You can select Auto-divide or specify the number of
repeating units along two directions.
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Define Motif

Refine Motif using high x-Corr Patches...
Discriminate Motifs...

Refine Motif Positions...

Component

Description

Define Motif

Defines a Rectangle ROI as a Motif, and make it
rotatable.

Refine Motif using high
x-Corr Patches...
(see Dialog)

Calculates Cross-Correlation Histogram between the
selected reference region (motif) and the original
image, and obtains a refined motif using high-scored
patches above the threshold.

Note: The left edge of the selection in the histogram
defines the threshold.

Discriminate Motifs

Calculates Cross-Correlation Histogram between the
refined motif and the original image, where you can
set the threshold for the good motif.

Note: The left edge of the selection in the histogram
defines the threshold.

Refine Motif Positions...
(see Dialog)

Refines Motif positions by fitting a quadratic function
to cross-correlation peaks.

Refine Motif using high x-Corr Patches Dialog

Dialog

x-Corr Histogram X

[l Invert Contrast

Minimum Motif Distance:

[l Show Original Motif

Cancel

Component

Description

Project Name

Name given to the group of images and results

Invert Contrast

If you want to analyze the hollows (dips), not peaks,
you should check this item.

Minimum Motif Distance

Specifies a minimum distance between allowed
motifs. This parameter can be changed at Refine
Motif Positions.

Show Original Motif

If checked, the original motif will be displayed.
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Peak Threshold:
Minimum Peak Distance:

Show All Local Maxima
Show stacked motif
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Component Description

Peak Threshold Specifies the minimum value for the cross-correlation

Discriminate Motifs.

peak. The default value is the threshold obtained at

Minimum Motif Distance | Specifies a minimum distance between allowed

motifs. The default value is carried from Refine Motif
using high x-Corr Patches.

Show All Local Maxima | If checked, the Motif centers rejected by the Peak

Threshold and/or the Minimum Motif Distance will
be shown in blue. (Namely, all the motif centers are
displayed in red or blue color.)

Show stacked motif If checked, a stacked image of the good motifs will be

created.
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Refine Peak Positions...

Remove Peaks

Add Peaks

Component

Description

Discriminate Peaks

Shows a histogram of peaks intensities, helping the
user to determine the threshold for peak intensity.

Note: The left edge of the selection in the histogram
is used as a threshold for good peaks.

Refine Peak Positions...
(see Dialog)

Refines peak positions by fitting a quadratic function
to intensity around the peaks.
The peaks within a minimum distance will be merged.

Remove Peaks

Remove the peaks, which are selected by using
HREM Mouse.

Add Peaks

Refine and add the peaks, which are selected by
using HREM Mouse.

Refine Peak Positions Dialog

Dialog

Find Peaks X

Using Intensity on

OriginalImage ~
EEELRIIEE I 0.825

Typical Peak Width (FWHM):

FWHM: Full-Width at Half-Maximum
[l Show All Local Maxima

Component

Description

Using Intensity on

Select the project or original image where the peaks
to be searched.

Peak Threshold

Specifies a minimum for the intensity of allowed
peaks. The default value is the threshold obtained at
Discriminate Peaks.

Typical Peak Width
(FWHM)

Specifies a typical peak width (FWHM in pixels). This
value will be used to merge the peaks.

Show All Local Maxima

Shows local maxima (of 8-neighbourhood) as blue
points.
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iz Strain Map

Option

Angle of x-axis to horizontal: | 0.0

Show the following images
[V Strain Matrix
Independent
@ Symmetric
[¥|Mean Dilatation
[V|Rotation Angle

("] overlay

[ OK ][ Cancel J

L A

Option

Description

Angle of x-axis to
horizontal

Specifies the angle of the direction to be considered
as x-axis.

You can specify the orientation of the x-axis by
placing a Line ROI on the HREM image. In this case,
the angle of the Line ROl appears here automatically.

Note: If angle is set equal to 0, the x coordinate axis
is assumed to be horizontal.

Strain Matrix

Specifies the images to be shown

Independent Images of du/dx, du/dy, dv/dx, dv/dy will be displayed
Symmetric Images of gxx, gyy and exy will be displayed.
Mean Dilatation Image of dxy will be displayed (average of exxand gyy).
Rotation Angle Image of wxy will be displayed. Values in degrees and
anticlockwise positive.
Overlay Shows the strain at each atomic column, and

displayed as colored dots over the original image
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Correct Scan Line Noise Dialog

Dialog iz Correct Scan ... S
[ correct All Line
[ OK ] [ Cancel ]
Component Description
Correct All Line When checked, all the scan lines, below and above
the ROI, will be corrected.

Distortion Correction Submenu Obtain Distortion Info...
Apply Distortion Info...

Command Description
Obtain Distortion Info... | Extracts distortion information from the image of an
(see Dialog) undistorted crystal using the knowledge of peak-

pairs. This information will be used by the “Apply
Distortion Info” command.

NOTE: Using this command, you can rectify any
image distortions appeared at the image of an
undistorted sample.

Apply Distortion Info... Corrects a distorted image using the distortion
(see Dialog) information obtained from the image of an undistorted
sample.
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Obtain Distortion Info Dialog

Dialog Obtain Distortion Info %
Rectify Image:
The lengths and angles of the refined base vectors
shown in the parentheses differ from the expected
unit cell. you can input the ideal values in the text boxes.
Then, the distortion information corresponding to
the ideal base vectors will be obtained.
Base Vector 1
Length: (8.49408)
aule| (5 -135.1 (-135.117)
Base Vector2
Length: (8.47219)
Angle: m (135.076)
o
Component \ Description

Base Vector 1 and Base Vector 2

The values in the parentheses correspond to the
refined base vectors. You can modify them by typing
the values in the boxes.

Length Length of base vector considered for image
rectification, measured in pixels.
Angle Angle of base vector considered for image

rectification, measured in degrees from the horizontal
axis.

Apply Distortion Info Dialog

Dlalog Correct Distortion X
IEICEAEREE C: Testimage 256k v
DIEIGHITL M D: Substrate_corrected 256k v
Component Description

Target Image

Length of base vector considered for image
rectification, measured in pixels

Distortion Info

Length of base vector considered for image
rectification, measured in pixels
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Dialog

==

iz Repeat Project

New Project: |Proiect3

Project image to be repeated:

=

Project! Bragg Filtered Testimage

Select
{” Find Peaks
(" Find Peak Pairs
(" Displacement Maps
{¢ Strain Map

oK | Cancel |

L A

Component

Description

New Project

Defines the name of the new project.

Project image to be
repeated

Selects an open project to be used to generate strain
maps and other outputs for the front most image.
Note: If you want to use the project created during
the previous session, you may want to open it again.

Find Peaks

Repeats Find Peaks Operation.

Find Peak Pairs

Repeats Find Peak Pairs Operation.

Displacement Maps

Repeats Displacement Maps Operation.

Strain Map

Repeats Strain Map Operation.

Project Submenu

Hide
Show
Save

Save And Close

Close
Component Description
Hide Hides all the images belong to a project.
Show Shows all the images belong to a hidden project.
Save Saves all the images belong to a project (with save

dialog window).

Save And Close

Closes all the images belong to a project after saving
them.

Close

Closes all the images belong to a project without
saving.
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S
Image Group Sub-Menu m

Component Description

Save Saves all images of the same type belong to a project
(e.g. strain map images).

Close Closes without saving all images of the same type
belong to a project.

Analyze Equivalent Columns Dialog

The user will have the option to output the distances and/or angles by placing the
check(s) on the box(es).

Distance Tab t‘#: Analyze Equivalent Columns [i_hJ

Distance IAngle ] Option ]

1 @2 003

Distances from the checked point(s) to
other points will be evaluated.

[ OK ][ Cancel ]

The number of each check box corresponds to the assigned number to the mouse
click. All the distance(s) from the checked point to other points will be calculated.

Angle Tab t%: Analyze Equivalent Columns &J

Distance Angle IOption]

1 @2 003

Checked point(s) will be a vertex of angle(s)
subtended by two other points.

[ OK ][ Cancel ]

The number of each check box corresponds to the assigned number to the mouse
click. All the angles at the checked point subtended by two other points will be
calculated.
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Optlon Tab Analyze Equivalent Columns X
DIEEN Il Option
Group number on the image
Column coordinate: Q) Image origin (top-leff)
@ Motif origin (top-left)
Component Description
Group number on the Display the group number (corresponds to the left
image column of the spread sheet) on original image.

Column coordinate

In the case of Motif Detection, you can select the
coordinates of column positions from Image or Motif
origin.

Distortion Analysis Submenu

Measure Distortion...

Show Motif Positions...
Show Arrows...

Show Color Map...

Update Front Image...

Command Description
Measure Distortion... At first, distortion values will be measured by running
(see Dialog) the saved script. This command will open the dialog

to select the script.

NOTE: Alternatively, the distortions will be directly
measured by executing the script from the script
window.

Show Motif Positions...

Displays the motif positions on the original image.

(see Dialog)

Show Arrows... Displays the distortions measured by using
(see Dialog) PPAPrepArrow in an arrow map.

Show Color Map... Displays the distortions measured by using
(see Dialog) PPAPrepColorMap in a color map.

Update Front Image...

The dialog for the Show Arrows or Show Color Map
will open according to the type of the front image.
Using the dialog, you can change the appearance of
the arrows or color map.
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Measure Distortion Dialog

Dialog E&ﬂ MeasureDistortion X
Select Evalustion Script | ...tAnalysis¥TestMean.s
Qutput Spreadsheet Name:
| QuantumWwire_S51
Find Peaks within | 5.0 pixels
oK Cancel
Component Description

Select Evaluation Script

Clicking on this button will open the file browser to
select the saved script.

NOTE: If you directly execute the script from the
script window, you will have a dialog without the file
selection capability.

Output Spreadsheet
Name

Specify an output spreadsheet name. The measured
distortion values will be saved as a spreadsheet.

Find Peaks within

Peaks will be searched in the specified area in pixel
from the corresponding points in the Motif.

Show Motif Positions Dialogq

Dialog

Component

Description

Select Spreadsheet

Select the spreadsheet corresponding to the ROl and
mouse points.
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Dialog i Show Arrows X
Show Arrows for |testlarrow v
X,y components VX [F
Show Motif Positions
OK Cancel
Component Description

Show Arrows for

Select the column in the spreadsheet corresponding

to the arrows to be drawn.

Output value selector

Select the value(s) to be drawn and input the scale.

Show Motif Positions

Shows the potions of the approximate motif centers.

Show Color Map Dialog

Dialog

E%j Show Color Map

Show Color Map for | test1 color map

Display Type
(® Polygon

(Ocirde  Radius |5 Pixel

Display Range (Percentile)
Low |0 % High | 100 %
Show Motif Positions

OK Cancel

Component

Description

Show Color map for

Select the column in the spreadsheet corresponding
to the measured values to be drawn as a color map.

Display Type

Select the display type from Polygon and Circle. In
the case of the circle, the radius of the circle can be

specified in pixels.

Display Range

The display ranges will be specified in percentiles.

Show Motif Positions

If the display type is Circle, the potions of the
approximate motif centers can be drawn.
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Show/Hide Submenu Peaks
Peak Pairs
Peaks And Peak Pairs
Motif
Command Description
Peaks Hides the circles at the peak positions, or shows
again when the peaks are in a hidden state.
Peak Pairs Hides the lines connecting the peak-pairs, or shows

again when the peak-pair lines are in a hidden state.

Peaks And Peak Pairs Hides the circles at the peak positions and/or the
lines connecting the peak-pairs, or shows again when
the circles and/or lines are in a hidden state.

Motif Shows the refined Motif of the project, when it has
been closed. This is useful to check the motif of the
project.

Create Vector Map Dialog
Dialog iz Create Vector Map 2% |

Select two components

Horizontal: [O: Project2 D1h v ]

Vertical: [S: Project2 D1v v ]

Arrow

Interval: |16| pixels
Length Scale: | 1.0

(Length = Scale * Interval)
Color: R [100 % G |20 % B |50 %

[ OK ] [ Cancel ]

Component Description

Horizontal Select an image corresponding to the horizontal
component.

Vertical Select an image corresponding to the vertical
component.

Interval Specifies a distance between the arrows (in pixel)

Length Scale Specifies an arrow length. An actual length is
Interval * this Scale (in pixel)

Color Specifies an arrow color in RGB.

78



HREM Research Inc.

PPA for DM Manual

Show Ideal Positions Submenu Obtain Distortion Info..
Apply Distortion Info...

Command Description

Lattice... Using the reference base vectors, the ideal lattice is

(see Dialog)

drawn on the original image or the project image. The
ideal lattice can be shifted using the arrow keys.

Equivalent Points...
(see Dialog)

Using the reference base vectors, the ideal
equivalent positions are drawn on the original image
or the project image. All the ideal points can be
shifted using the arrow keys.

Show Ideal Lattice Dialog

Dialog

Show Ideal Lattice X

Use mouse point
DIELIEVAGLN Original Image  ~

[l Create a duplicate image

Component

Description

Use mouse point

Select one mouse point from the list to be used for
drawing the lattice.

Display on

Select the image where the lattice is displayed.

Create a duplicate
image

When checked, the lattice is displayed after
duplicating the selected image.

Show Ideal Equivalent Positions Dialog

Dialog

Show Ideal Equivalent Points

Use mouse point

a1 F2 F3

DIELIEVELE Original Image  ~

Create a duplicate image

Component

Description

Use mouse points

Select the mouse points to be displayed by checking
the boxes.
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Display on Select the image where the equivalent points are
displayed.

Create a duplicate When checked, the equivalent points are displayed

image after duplicating the selected image.
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